File Menu

ltem

New

Open...
Quick Open

Import Multiple
Files...

Close

Close Project
Save

Save As...
Revert

Save Project

Save Project As...

Archive Project...

Export...

Publish...

Database

Internet Open...

SAS

Preferences

Print...

Print Preview

JMP 15

Windows Menu Descriptions

Description

Creates a new data table, script, journal, database query, project, application, dashboard, or
add-in.

Locates and opens files of various types.
Enables you to enter a search term and find recently opened files from any JMP window.

Opens multiple files from a folder, combining similar files into data tables.

Closes the active window. Prompts you to save changes.

Closes the current project. Available only when a project is open.

Writes the active window to a file, providing a choice of appropriate extensions.

Writes the active window to a file after prompting you for a filename and type.

Restores the current JMP file to its last saved condition.

Saves the current project. Available only when a project is unsaved.

Saves the current project using the specified name. Available only when a project is open.
Compresses the project files in a ZIP file. Available only when a project is open.

Exports the file to text, an image, PDF, HTML, Interactive HTML with Data, RTF, Microsoft
PowerPoint, or Microsoft Word.

Publishes the current reports to a web page with an index page. You may also publish to JMP Live
or JMP Public, two ways to quickly share reports with other users.

Opens the Query Builder for interactively building SQL queries; opens a connection to any
database on your system that has an ODBC driver; and opens or saves a data table.

Opens remote files in a browser or text editor window, and opens an HTML table as a data table.
Enables you to open JMP data tables and run scripts from a URL. Also provides a way to publish
data as a Google Sheets.

Connects to a SAS server; opens the SAS Query Builder for interactively building SQL queries; lets
you browse and run SAS stored processes or open SAS data files and folders; provides an editor
window; sends SAS code from JMP to the currently active SAS server; opens SAS Log and Output
windows; and exports data to SAS.

Lets you specify options and settings for start-up items, reports, tables, analysis platforms, import
and export settings, graphic formats, fonts, SAS integration, and more. Also lets you reset
defaults.

Prints the active window.

Displays the contents of the active window in print view.



File Menu (Continued)

ltem
Page Setup...
Recent Files

Save Session
Script...

Exit ]MP

Edit Menu

Item
Undo
Redo

Cut

Copy

Copy As Text

Copy With Full
Precision

Copy With Column
Names

Paste

Paste With Column
Names

Clear

Select All

Save Selection As...

Encrypt Script...

Decrypt Script...

Description
Displays the standard window for setting printed page properties.
Displays a list of the most recently opened files for easy re-opening.

Creates a JMP Scripting Language (JSL) script to re-open all currently open files and re-run all
currently open analyses and graphs.

Closes all JMP windows and quits JMP. Prompts you to save new or changed JMP files. Also asks
whether you want to save the session script.

Description
Cancels the effect of the most recent reversible Edit, Rows, or Columns command.
Reverses the most recent Undo command.

Copies selected data table cells to the clipboard and replaces the data with missing values. In
reports and other windows, copies selected content to the clipboard.

Copies selected data table cells to the clipboard. In reports and other windows, copies selected
content to the clipboard.

Copies all text (but no graphs), or text selected using the selection tool, from the active report
window to the clipboard.

Enables you to copy a column of numeric data and maintain the full precision. Applies only to the
fixed decimal format.

Copies selected data table cells and column names to the clipboard.

Copies content from the clipboard into the open window.

Copies data from the clipboard into the active data table. Converts text on the first line of the
clipboard to column names.

Removes selected data table cell contents and adds missing values. In journal and script windows,
removes selected content.

Selects all rows in a data table. In reports and other windows, selects all content when one item is
selected.

Saves selected portions of an analysis window in a graphic format.

Places encoding in a script so that you must have the password to open or run the script. Only
available if an unencrypted script is in the active window. When an encrypted script is in the
active window, the menu item changes to Decrypt Script.

Lets you open or run an encrypted script. Only available if an encrypted script is in the active
window.



Edit Menu (Continued)

ltem

Import as Data

Run Script

Debug Script
Stop Script
Submit to SAS
Search

Go to Line...

Balance

Reformat Script

Journal

Properties

Tables Menu

ltem

Summary

Subset

Sort

Stack

Split

Transpose

Join

Update

Description

Imports text-formatted data using the Import Settings in File > Preferences > Text Data Files.
Before invoking the Import as Data command, you must paste the data into a script window, and
that window must be active.

Processes JSL commands entered in the script window. You are prompted to select a data table, if
none are opened. If several data tables are opened, the script is run on the last table that you
opened. Otherwise, the script is run on the only open table.

Lets you troubleshoot script errors in a new script window.

Stops running a JSL script.

Connects to a specified SAS server and submits SAS code directly from JMP.
Finds and replaces text in data tables and scripts.

Scrolls to a specific line number in a script.

Selects all text within a pair of brackets that include the cursor. Only available if a script window is
active.

Adds tab and return characters where appropriate to display the script in more readable layout.

Copies output from a data table or report window to a journal window. Lets you save reports, add
notes, and organize output.

Enables you to modify the formatting of display boxes in a report.

Description

Creates a table that contains user-specified summary statistics calculated from the active
data table.

Creates a new data table that is a subset of the active data table and can be linked to the original
table.

Sorts a JMP data table by one or more columns. This creates a new data table, or you can replace
the original table with the sorted table.

Stacks specified columns into one or more new columns in a new data table.

Splits one or more columns, according to values in a Split By column, to form multiple columns in
a new data table.

Creates a new data table where the data in the selected columns of the original table are arranged
in rows. This equates to switching the rows and columns in the original selection.

Adds columns from a second table to the main table, using row number or matching columns, or
by forming a Cartesian join.

Replaces data in the active table with data from a second table without producing a new table.



Tables Menu (Continued)

Item
Concatenate
JMP Query Builder

Missing Data
Pattern

Compare Data
Tables

Anonymize

Rows Menu

Item

Hide and Exclude
Exclude/Unexclude
Hide/Unhide
Label/Unlabel
Colors

Markers

Next Selected
Previous Selected
Row Selection
Clear Row States

Clear Selected Row
States

Color or Mark by
Column...

Row Editor
Delete Rows
Add Rows...
Move Rows...

Data Filter

Description
Stacks two or more tables on top of each other by matching column names.
Interactively queries one or more data tables to create a new data table.

Describes the missing data in your table in terms of the columns where it is missing.

Compares the numbers of columns and rows, table properties and scripts, column attributes and
properties, and data in two open data tables.

Removes unique identifiers from the data table or specific columns.

Description

Hides and excludes selected rows in plots and analyses.

Excludes or includes selected rows in analyses.

Hides or shows selected points in all plots.

Labels or unlabels selected points in all plots.

Changes selected points in all plots to a specified color.

Replaces selected points in all plots with symbols that you select.

Locates and flashes the first selected row in a data table after the current row.
Locates and flashes the first selected row in a data table before the current row.
Provides several options for selecting rows based on one or more conditions.
Clears all active row states in the data table.

Clears all selected row states in the data table.

Assigns colors or markers to rows based on values in a selected column.

Opens a window that lets you edit cells in a row. Helps you select rows and create new rows.
Removes all selected rows from the data table.

Adds rows to a specified location in the data table.

Moves selected rows to a specified location in the data table.

Selects, shows, or includes rows based on conditions on the values of specified columns.



Cols Menu

Item
New Columns...

Column Selection
Reorder Columns
Column Info...
Standardize
Attributes...
Preselect Role
Formula...
Label/Unlabel

Scroll Lock/Unlock

Hide/Unhide

Exclude/Unexclude

Use for Marker
Recode...

Columns Viewer

Utilities

Clear Cell Colors

Group Columns

Ungroup Columns

Delete Columns

Description
Adds a new column, and lets you name the column and change attributes and properties.

Highlights and scrolls to the specified column. Locates and flashes the first or next selected
column in a data table after the current column. Selects any column that is currently deselected
and deselects any column that is currently selected.

Moves the selected column to the specified location. Rearranges columns by the original order,
name, data type, modeling type, or in reverse order.

Displays and allows changes to column name, attributes, and properties for selected column or
columns.

Sets attributes and properties for multiple columns at once.

Assigns an analysis role, which can be saved with the data table, to selected column or columns.
Shows the formula editor window for selected column or columns.

Tells JMP whether to use values from the selected column or columns to identify points in plots
when the cursor is placed near them. To display labels for points on plots, the corresponding rows
must have a label row state.

Locks or unlocks selected columns into or from the left-most position in the table. Locking a
column keeps its contents visible when you scroll horizontally.

Hides or shows selected columns without removing them from the table. Retains them in
analyses.

Excludes or includes selected columns in analyses.
Displays the images in expression columns as markers on graphs.
Enables you to edit and group similar values in a column.

Provides a quick way to view columns using specific criteria (such as column names, properties,
and attributes). You can then view summary statistics and properties for those columns, view
quartiles in the summary statistics, show the columns in a separate data table, and more.

Restructures data. Compresses columns, converts a column of delimited data to multiple
columns, creates indicator columns, combines columns, customizes binned data, converts a
numeric column of codes to value labels, converts a column of strings to numeric codes, and
recodes column names.

Clears the color of selected colored data table cells.

Groups columns under one heading to manage large numbers of columns and facilitate analysis
role assignment. Grouped columns are shown in outline view under a gray disclosure icon in the
columns panel.

Removes the grouping heading and displays individual column names in column panel and
analyses.

Removes selected columns from the data table.



DOE Menu

Item
Custom Design

Augment Design

Definitive
Screening

Classical

Design Diagnostics

Consumer Studies

Description
Creates D-optimal and I-optimal designs for a wide range of design situations and constraints.

Adds runs to an existing design in an optimal fashion. Provides various choices for how to add
these runs.

* Definitive Screening Design creates a design with three levels for every quantitative factor.
Main effects are independent of two-factor interactions, and two-factor interactions are not
confounded with each other.

* Fit Definitive Screening provides options for modeling definitive screening designs.

* Screening Design constructs classical and main effects screening designs. The factors can be
2-level continuous, discrete numeric, and categorical factors with an arbitrary number of
levels.

* Fit Two Level Screening provides options for modeling screening designs.

* Response Surface Design generates a list of classical response surface designs for the specified
number of continuous factors and creates the chosen design.

¢ Full Factorial Design creates a design using all combinations of factor levels for a set of
continuous and categorical factors with an arbitrary number of levels.

* Mixture Design creates a design that is appropriate when the factors are components in a
mixture. Some design types accommodate linear constraints.

* Taguchi Arrays constructs a Taguchi design. Signal and noise factors, a choice of inner and
outer array designs, and signal-to-noise ratios are supported.

* Evaluate Designs evaluates designs for any table treated as a design. You can modify the
model terms and the aliasing terms, and the diagnostics update accordingly.

* Compare Designs compares two or three designs simultaneously to explore and evaluate their
performance. Provides diagnostics that show how the designs perform relative to each other
as well as how they perform in an absolute sense.

* Sample Size and Power computes power, sample size, and effect size for means, variance,
proportions, and counts. The platform also computes sigma quality level and more.

* Choice Design creates an optimal discrete choice conjoint experimental design. These designs
are useful in studies where users are asked to specify preferences relative to combinations of
product or service features.

* MaxDiff Design constructs a design consisting of choice sets that can be presented to
respondents as part of a study where respondents specify most and least preferred
combinations of features.



DOE Menu (Continued)
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Special Purpose

Analyze Menu

ltem

Distribution

Fit Y by X

Tabulate

Text Explorer

Fit Model

Predictive
Modeling

Specialized
Modeling

Description

e Covering Array creates a design for testing systems where failures occur as a result of
interactions among components or subsystems (JMP Pro).

¢ Space Filling Design creates a design that is appropriate when modeling deterministic or
nearly deterministic systems, such as computer simulations.

® Accelerated Life Test Design constructs tests based on one or two accelerating factors with
either a main effects model or an interaction model for the latter.

* Nonlinear Design creates an optimal design for estimating the parameters of a nonlinear
model.

e Balanced Incomplete Block Design creates a design for testing a treatments in b blocks where
only k treatments (k < a) can be run in any one block.

*  Group Orthogonal Supersaturated Design creates a supersaturated design where the factors
are partitioned into k orthogonal groups, with k=2 or a multiple of 4.

¢ Fit Group Orthogonal Supersaturated provides options for modeling a group orthogonal
supersaturated design.

Description

Provides a histogram for continuous data and a bar chart for nominal or ordinal data, along with
relevant summary statistics. Presents options for many one-sample analyses, based on modeling

type.

Shows plots that describe the relationship between any two variables. Provides two-sample
analyses based on the modeling types of the two variables, such as bivariate, oneway, logistic, and
contingency analysis.

Constructs tables of descriptive statistics using an interactive interface.

Analyzes pieces of unstructured text, such as comment fields in surveys or incident reports,
enabling you to interact with the text data with tools to consolidate similar terms, recode
misspecified terms, and gain understanding of the underlying patterns in your textual data.
(Analytics are available in JMP Pro.)

Fits models involving one or more Y variables and multiple X variables. Techniques include
standard least squares, stepwise, generalized regression (JMP Pro), mixed models (JMP Pro),
MANOVA, loglinear variance, logistic, proportional hazards, parametric survival, generalized
linear models, partial least squares (JMP Pro), and response screening.

Offers predictive modeling techniques: neural, partition analysis, bootstrap forest (J]MP Pro),
boosted tree (JMP Pro), K nearest neighbors (JMP Pro), naive Bayes (JMP Pro), support vector
machines (JMP Pro), and model comparison (JMP Pro). The menu also provides options to make
validation columns and access prediction models that you saved in the Formula Depot (JMP Pro).

Offers specialized modeling techniques: nonlinear, functional data exploration, Gaussian process,
time series, and matched pairs.



Analyze Menu

ltem

Screening

Multivariate
Methods

Clustering

Quality and Process

Reliability and

Survival

Consumer Research

Graph Menu

ltem

Graph Builder

Bubble Plot

Scatterplot Matrix

(Continued)

Description

Offers techniques for screening large data sets, including analyzing outliers and missing values.
Response Screening automates the process of conducting tests across a large number of responses.
Process Screening addresses process stability and capability for large numbers of processes,
presenting summary statistics in a compact tabular format. Predictor Screening is useful in
screening a data set for significant predictors. Association Analysis analyzes transaction (market
basket) data to identify items that appear together in transactions (JMP Pro). Process History
Explorer analyzes complex processes to identify where a defect has occurred.

Offers techniques for exploring relationships among multiple variables: multivariate fitting,
principal components, discriminant analysis, partial least squares, multiple correspondence
analysis, structural equation models (JMP Pro), factor analysis, multidimensional scaling, and
item analysis.

Offers techniques for clustering: hierarchical clustering, K means clustering, normal mixture
clustering, clustering rows based on categorical variables using multinomial mixtures (latent class
analysis), and clustering variables into groups of highly correlated variables.

Offers techniques for evaluating quality-related issues in processes or products: control charts
(including an interactive control chart builder), measurement systems analysis, variability and
attribute gauge charts, process capability analysis (including capability for non-normal process
measurements), CUSUM control charts, model-driven multivariate control charts, legacy control
charts, Pareto plots, and fishbone (Ishikawa Cause and Effect) diagrams. You can also manage
spec limits.

Offers techniques for fitting survival and reliability data: life distribution, fit life by x, cumulative
damage, recurrence analysis, degradation and destructive degradation, reliability growth and
forecasting, reliability block diagrams (JMP Pro), repairable systems simulation (JMP Pro),
product-limit survival fit, parametric survival distributions, and proportional hazards modeling.

Offers techniques for studying consumer preferences. Options include categorical response
survey analysis, choice models, MaxDiff analysis, uplift models for identifying the positive effects
of marketing actions (JMP Pro), and multiple factor analysis.

Description

Provides an interactive interface to create flexible trellis displays that are useful for visualizing
multivariate data. Plots can be conditioned on discrete and continuous variables and include dot
plots, smooth curves, normal density ellipses, box plots, lines, bar charts, and histograms. Available
plots include contour plots, maps, parallel plots, mosaic plots, pie charts, treemaps, area charts, heat
maps, formula charts, and line of fit. Map shapes are also supported.

Displays circles according to positional specification. Circles can be sized and colored according to
selected variables. When there is a time variable, selected variables can be viewed dynamically over
time.

Displays scatterplots and density ellipses for all pairs of Y variables, or for a selection of Y variables
plotted against one or more X variables.



Graph Menu (Continued)

Item
Parallel Plot

Cell Plot

Scatterplot 3D

Contour Plot

Ternary Plot

Surface Plot

Profiler

Contour Profiler

Mixture Profiler

Custom Profiler

Excel Profiler

Legacy

Description
Draws a plot that connects the values of selected Y variables for each row in the data table.

Creates a rectangular array of cells drawn with a one-to-one correspondence to data table values,
and colored by the values in the cells.

Creates three-dimensional rotatable plots for multiple Y variables. Displays and saves principal
components, standardized principal components, and rotated components. Also displays normal
contour ellipsoids, nonparametric density contours, and biplot rays.

Constructs contour plots for one or more numeric response variables, Y, across a grid defined by
two numeric X variables.

Illustrates the distribution of three-part (numeric) compositional data, using a two-dimensional
plot.

Creates a three-dimensional, rotatable display of points or of a surface defined by a saved formula.

Displays prediction traces for each X variable, based on saved prediction formulas for each numeric
response and linear constraints on the X variables. Allows simultaneous optimization of responses
using desirability functions, estimation of response distributions using the simulator, and accesses
and links to other profilers. Can be saved as an Adobe Flash file (.swf) to display in a web browser.

Displays contours of the prediction formulas for two factors at a time, along with three-dimensional
mesh plots. Accesses the simulator, and links to other profilers.

Displays a ternary plot and contours of the prediction formula for models involving mixture factors.
Accesses the simulator, and links to other profilers.

Provides an interface for simultaneous optimization of responses, similar in function to the profiler.
Allows linear constraints and a user-defined criterion for optimization, and displays predicted
performance relative to benchmarks. Accesses the simulator, and links to other profilers.

Provides a method for transferring Excel data to JMP. You can then analyze the data using JMP’s
profilers.

Provides access to graphs that you can now create in Graph Builder.

¢ Treemap creates a rectangular tiling for a nominal or ordinal variable where you can tile
categories to be proportional in size to the counts of categories within a selected variable. A
positional specification is optional.

® Chart plots bar, line, pie, needle, and point charts of user-specified summary statistics for
multiple selected Ys across the values of up to two X variables.

* Overlay Plot plots one or more numeric Y variables across the values of a single X variable;
several plots are constructed in one window using grouping variables.



Tools Menu
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Arrow

Help

Selection
Scroller

Grabber

Brush

Lasso
Magnifier

Crosshairs
Annotate

Line, Polygon,
and Simple Shape

Project Menu

Item

Undo Layout
Redo Layout

Reset Layout
Show Window List

Show Bookmarks

Description

The default tool.

* Lets you select points in plots and analysis options. Drag the cursor to select multiple points.

* Rotates the plot in Surface Plot and Scatterplot 3D.
Opens context-sensitive Help when you click the help tool in any part of a display or report.

Lets you select rows or regions of rows when you click and drag. Selects portions of graphical
output or analysis results.

Scrolls a report or journal window in any direction with more precision than when using scroll bars.
The scroller is available in report windows and journal windows.

¢ Changes axis scaling when you hover with grabber and click over an axis. Hand changes
orientation to indicate direction of change.

¢ Changes both axes simultaneously when you click and drag within a plot.

¢ In histograms, changes the number of bars or shifts the boundaries of the bars on the axis when
you click and drag.

¢ In any report table, rearranges columns.

e In Surface Plot and Scatterplot 3D, click and drag an axis to move it. When you click the plot, the
grabber turns to an arrow and lets you rotate the plot.

Lets you select one or more points when you brush over them.

Lets you circle points with a curve. Hold down the SHIFT or CTRL key and circle more points to
extend a selection.

Lets you zoom in to a plot when you click where the enlarged graph should be centered.
Double-click to restore the graph to its original dimensions.

Displays a moveable set of magnified axes to precisely locate points and estimate distances on plots.
Lets you add editable text notes to JMP reports and journals.

Lets you draw lines, polygons, and shapes on JMP reports and journals. Right-click a line or shape
for a menu of options.

Description

Enables you to undo actions performed on the tabs.

Enables you to reverse actions performed on the tabs.
Returns all open reports and data tables to a tabbed view.
Opens or closes the Window List pane in the project window.

Opens or closes the Bookmarks pane in the project window.
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Project Menu (Continued)

Item
Show Recent Files

Show Log

View Menu

Item
Associated Data

JMP Starter

Home Window

Window List

Log
Status Bars

Thumbnail Panel

Home Window
Panes

Toolbars
Running Queries
Add-Ins...

Customize

Window Menu

Item
New Data View

Reveal

Close All of Same
Type

Close All
Applications

Description
Shows a list of recently used files, the same files shown on the Home Window.

Opens or closes the Log in the project window.

Description
Brings the data table for the open report to the front.

Opens and closes the JMP Starter window, which gives access to most commands found on the
main menu or on toolbars.

Opens and closes a window that lists recently opened JMP files and help files. Shows open JMP
windows in an outline view (the same list that appears when you select View > Window List).
Also lets you add frequently used files to a list of favorites.

Opens and closes a window that lists open windows. These windows are shown in an outline
view.

Opens a window that shows information such as JSL statements as they execute and script errors.
Opens and closes the status bar at the bottom of the JMP window.

Shows or hides the previews of open report windows. Available only in data tables when a report
window is open.

Lets you choose which panes to display on the Home Window. Also lets you revert your changes
to the JMP defaults. Available only from the Home Window.

Lets you add, remove, or revert to the original toolbars.
Lets you view ODBC queries that are running against an SQL database.
Lists the add-ins that you installed in JMP.

Lets you customize the toolbar and menu items and revert to the original settings.

Description
Displays a duplicate view of the active data table that is linked to the original data table.
Shows previews of all open JMP windows so that you can quickly open another window.

Closes all windows of the same type.

Closes all open applications and dashboards. Appears only when the active window is an
application or dashboard.
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Window Menu (Continued)

ltem

Close All Reports
Close All Journals
Close All Scripts

Close All Data
Tables

Close All
Minimize All
Restore All

Bring All Forward

Arrange

Combine
Windows...

Move to/from
Project...

Redraw
Font Sizes
Set Title

Move to Back

Hide
Unhide

Unhide All

Help Menu

Item
JMP Help

JMP
Documentation
Library

Discovering JMP

Description

Closes all open reports. Appears only when the active window is a report.

Closes all open journals. Appears only when the active window is a journal.
Closes all open scripts. Appears only when the active window is the script editor.

Closes all open data tables. Appears only when the active window is a data table.

Closes all open windows.
Minimizes all open windows.
Displays all minimized windows.
Brings all JMP windows to the front.

Shows options for selecting, displaying, and clearing selected windows. After you select
windows, the Arrange Selected Windows option appears, which shows all selected windows
side-by-side. After you select a report, the Arrange With Data Table option appears, which shows
the report next to its data table.

Lets you select open J]MP windows and merge them into a dashboard. Options include using a
report as a selection data filter and displaying in Full or Summary view.

Enables you to move selected windows to or from a new or open project.

Refreshes a window after it shows stray imperfections from high-speed, dynamic handling.
Increases and decreases the size of text in all open windows.
Lets you change the name of the active JMP window.

Moves the active window behind all other JMP windows and shows the next window in the
sequence.

Suppresses the display of the active window but does not close the window.
Lets you select the hidden windows that you want to view.

Lets you unhide all hidden windows.

Description
Opens the online JMP Help system.

Opens a PDF file that contains all JMP books.

Opens the Discovering JMP PDF file.
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Help Menu (Continued)

Item
New Features

Quick Reference
Card

Menu Card

Sample Data
Library
JMP on the Web

Tutorials
Tip of the Day

Statistics Index

Scripting Index

Sample Data

Renew License

About JMP

Description
Opens the New Features PDF file for the main JMP release.

Opens the quick reference card PDF file, which provides keyboard shortcuts for Windows and
macOS.

Opens the Windows menu card PDF file.

Opens a list of JMP sample data tables.

Opens the JMP website, JMP Welcome Kit, JMP User Community, Statistical Thinking Course, and
Statistics Knowledge Portal.

Opens a set of JMP tutorials.
Opens the Tip of the Day window, which provides tips about using JMP.

Defines statistical terms, opens online Help, launches analysis platforms, and lets you run scripts
that illustrate the terms.

Defines JSL functions, JSL objects, and display box elements. Several search options are available.
You can also run examples and read online Help for the components. Above the list of commands,
select All Categories to search all functions, objects, and display box elements.

Opens the Sample Data Index window, which provides links to sample files. Many sample data
tables include scripts that you can run to see examples of JMP tools and analyses. You can also run
the sample scripts themselves to see examples of JMP tools and analyses.

Lets you select a new license file to renew the license. Available only in annual license copies
during the grace period and before the license expires.

Displays product version, registration, user and system information, the JMP web page link, and
more.

The Format menu appears only when an application or dashboard is open.

Format Menu

Item

Add Module
Delete Module
Align Boxes

Add Container

Remove Container

Description

Creates a new empty module.

Removes the currently displayed module from the application.

Lines up the selected objects by the type of alignment that you select from the submenu.
Places the selected object inside the object that you select from the submenu.

Removes the selected object from its container.
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